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About FortiManager for GCP

FortiManager's security-operationalized visibility across your Fortinet Security Fabric enables true security effectiveness
and foresight to identify and understand the scope of threats and facilitates actionable responses and risk remediation.

Quantifiable security solution information produces measurable accountability and uses those ratings to compare your
security preparedness internally and to that of your industry peers.

Centralized change management helps you update policies and objects, maintain provisioning templates, and easily
configure changes to your APs, switches, SD-WAN and SDN connectors and more to mitigate security events and apply
configuration changes and policy updates.

Network administrators can better control their network by logically grouping devices into administrative domains
(ADOMs), effectively applying policies and distributing content security/firmware updates. FortiManager is one of
several versatile network security management products that provide diversity of deployment types, growth flexibility,
advanced customization through APIs, and simple licensing, all through central management and configuration.

Machine type support

FortiManager for GCP can be deployed as VM instances. Supported machine types may change without notice.
Currently FortiManager supports standard machine types, high memory machine types, and high CPU machine types
with minimum 2 vCPUs and 7.5 GB of RAM and maximum 96 vCPUs and 624 GB of RAM in the predefined machine
type lineup. You can also customize the combination of vCPU and RAM sizes within this range. More details on
predefined machine types can be found here.

Latest supported machine types can be seen under machine type selection if you try to launch FortiManager from the
marketplace listing or Compute Engine portal.

Models

FortiManager-VM is licensed based on the number of managed devices, amount of logging per day, and storage
capacity. Refer to price lists and order SKUs available through your resellers/distributors. These are also referred to as
bring your own license (BYOL) models.

FortiManager-VM can be deployed using different CPU and RAM sizes and launched on various private and public cloud
platforms.

Licensing

You must have a license to deploy FortiManager for GCP. The following sections provide information on licensing
FortiManager for GCP:
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About FortiManager for GCP 5

o Order types on page 5
« Creating a support account on page 5
« Registering and downloading licenses on page 5

Order types

FortiManager for GCP supports only Bring Your Own License (BYOL). There is no Pay As You Go/On-Demand (PAYG)
subscription available yet.

BYOL is annual perpetual licensing, as opposed to PAYG, which is an hourly subscription available with marketplace-
listed products. BYOL licenses are available for purchase from resellers or your distributors, and prices are listed in the
publicly available price list that is updated quarterly. BYOL licensing provides the same ordering practice across all
private and public clouds, no matter what the platform is. You must activate a license for the first time you access the
instance from the GUI or CLI before you can start using various features.

Creating a support account

FortiManager-VM for GCP supports BYOL licensing models.
For BYOL, you typically order a combination of products and services, including support entitlement.

You must create a FortiCare support account and obtain a license to activate the product through the FortiCare support
portal.

Registering and downloading licenses

Licenses for the BYOL licensing model can be obtained through any Fortinet partner. If you don't have a partner, contact
gcpsales@fortinet.com for assistance in purchasing a license.

After you purchase a license or obtain an evaluation license, you will receive a PDF with an activation code.
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About FortiManager for GCP 6

1. Goto Customer Service & Support and create a new account or log in with an existing account.
2. Goto Asset > Register/Renew to start the registration process.

Registration
Wizard

Registering Product

nReg\s:rat\chode >'2 >3 > 4

Specify Registration Code

Please enter your product serial number, service contract registration code or license certificate number to start the registration:

End User Type

Please specify the type of user who will be using this product:

be used by a non-government user

ment department, ag s: including (1) governmental research institutions, (2) governmenta

itions List, and (3) internatio

nmental organizations.

Next

3. Inthe Specify Registration Code field, enter your license activation code, then select Next to continue registering
the product.

4. Enter your details in the other fields as required.

5. Atthe end of the registration process, download the license (.lic) file to your computer. You will upload this license
later to activate the FortiManager-VM.
After registering a license, Fortinet servers may take up to 30 minutes to fully recognize the new license. When you
upload the license (.lic) file to activate the FortiManager-VM, if you get an error that the license is invalid, wait 30
minutes and try again.
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Deploying FortiManager on GCP

To deploy FortiManager on GCP:

1. Inthe Google Cloud marketplace Cloud Launcher, find FortiManager Centralized Security Management.

FortiManager Centralized Security Management

r 11 Y Fortinet Inc

(i ER Estimated costs: $0.00/month + BYOL license fee
umw o g s o
E&:ATINET Simplify configuration and automate provisioning

LAUNCH ON COMPUTE ENGINE

Runs on Overview

Google Compute Engine FortiManager's Security Operationalized Visibility across your Fortinet Security Fabric enables true security

Type effectiveness and foresight to identify and understand the scope of threats, and facilites actionable response and
Single VM remediation of risks.
BYOL
+ Quantifiable Security solution information produce measureable accountability, and use those ratings to
Last updated compare your security preparedness internally and to that of your industry peers.
7/3/18,7:26 PM » Centralized Change Management helps you update policies and objects, maintain provisioning templates and

easily configure changes to your APs, Switches, SD-WAN and SDN connectors and more, to mitigate security

Category
events and apply configuration changes and policy updates.

Networking
2. Click LAUNCH ON COMPUTE ENGINE.

3. Configure the variables as required:

Deployment name Enter the name of the FortiManager-VM to appear in
the Compute Engine portal.

Zone Choose the zone to deploy the FortiManager to.
Machine type Choose the instance type required.
Boot disk type Choose the desired boot disk type.
Boot disk size in GB Leave as-is at 10 GB.
Note you must add additional disks for logging in later
steps.
Network name Select the network located in the selected zone.
Subnetwork name Select the subnet where the FortiManager resides.

Currently the Cloud Launcher solution supports one
network interface.

Firewall Leave all selected, or allow at least HTTPS if the
strictest security is allowed in your network as the first
setup. Change firewall settings as needed later.
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Deploying FortiManager on GCP 8

External IP Select Ephemeral. You will need to access the
FortiManager management GUI via this public IP
address.

Leave the other options as shown.
4. Click Deploy. When deployment is complete, the screen appears as below.

=™ @ FortiManager Centralized Security Management
r-;n:- Solution provided by Fortinet Inc.

Site address hitps://ANNESEENgS 143/ 7

Admin user admin

Admin password TR

(Temporary)

Instance jkato-fmg-564-test002

Instance zone us-central1-f

Instance machine type n1-standard-2

More about the software

Get started with FortiManager Centralized Security Management

Visit the site SSH | ~

Suggested next steps

Registering and downloading your license

Licenses for the BYOL licensing model can be obtained through any Fortinet partner. If you don't have a partner, contact
gcpsales@fortinet.com for assistance in purchasing a license.

After you purchase a license or obtain an evaluation license (60-day term), you will receive a PDF with an activation
code.
1. Goto Customer Service & Support and create a new account or log in with an existing account.

2. Goto Asset > Register/Renew to start the registration process. In the Specify Registration Code field, enter your
license activation code and select Next to continue registering the product. Enter your details in the other fields.

3. Atthe end of the registration process, download the license (.lic) file to your computer. You will upload this license
later to activate the FortiManager-VM.
After registering a license, Fortinet servers may take up to 30 minutes to fully recognize the new license. When you
upload the license (.lic) file to activate the FortiManager-VM, if you get an error that the license is invalid, wait 30
minutes and try again.
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Deploying FortiManager on GCP 9

Connecting to the FortiManager-VM

To connect to the FortiManager-VM, you need your login credentials and the FortiManager-VM's public DNS address.
From the previous step, there is a temporary admin password automatically generated on the Google Cloud.

1.

Connect to the FortiManager using your browser. You will see a certificate error message from your browser, which
is normal because the default FortiManager certificate is self-signed and not recognized by browsers. Proceed past
this error.

FortiManager-VMé64-GCP

u Username ]

u Password ]

2. Log into the FortiManager-VM with the username admin and the supplied temporary password.
3. Afteryou log in, click admin in the top-right corner to change the password. You are encouraged to change the

initial password as soon as possible.

==

Policy & Objects

@41 ’ admin v

[Change]

FortiManager-VMé4-GCP
v5.6.4 GA build4245

AP Manager

FortiGuard

Device Manager

]

FortiClient Manager

=N R

FortiSwitch Manager

& Change Password
(» Log Qut

La

VPN Manager

System Settings
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Deploying FortiManager on GCP

4. Afterlogging in again, go to System Settings.

Device Manager

FortiGuard

78 System Settings v

L TH

& Dashboard

& All ADOMs

€ Network

SIHA

2 Admin
Administrators
Profile
Remote Authentication Server
Admin Settings

BB Certificates
Local Certificates
CA Certificates
CRL

I& Event Log

[ Task Monitor

Es Advanced
SNMP
Mail Server
Syslog Server
Meta Fields

Advanced Settings

B

Policy & Objects

gle Widgets v

System Information
Host Name
Serial Number
Platform Type
HA Status
System Time
Firmware Version
System Configuration
Current Administrators
Up Time
Administrative Domain

FortiAnalyzer Features

System Resources

0%

Average CPU Usage

Tt e Pl

AP Manager

FMG-VM64-GCP

FMG-VM0O000000000

FMG-VM64-GCP

Standalone

Wed Jul 04 14:40:07 2018 PDT

v5.6.4-build4245 180627 (GA)

Last Backup : N/A

admin /1 in total

23 hours 4 minutes 30 seconds
ofF

OFF

=
11%

Memory Usage

]

FortiClient Manager

Iu

J

VPN Manager

10

Q1 1 admin v

o x License Information oox
7 | EVMLicense  Type Valid 2 |
[2 Management Devices/VDOMs 0of 10
© FortiGuard VM Meter Service  No License -
Server Location g Servers located in US only ya
rd &2 Update Server  Antivirus and IPS 65.210.95.241 (== United States)
& ‘Web and Email 96.45.33.64 (@3 Sunnyvale, CA, United
x Filter States)
i= FortiClient Update ~ 96.45.33.105 (& Sunnyvale, CA, United
States)
Unit Operation [k 4
el FORTINET

FortiManager-VMé4-

GCP

C Restart

Alert Message Console

EOC X

6. Upload the license file (.lic) from the PC to activate the FortiManager-VM. The system automatically restarts. After
it restarts, wait about 30 minutes until the license is fully registered at Fortinet, then log in again.

Upload Device License

Upload file by drag & drop here ori

Adding a disk to the FortiManager-VM for logging

You are required to add another disk to store logs.

FortiManager GCP Cookbook
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Deploying FortiManager on GCP

1. Log into the GCP Compute Engine.

2. Gotothe Disks page.

11

3. Create a blank disk in the same zone where the FortiManager-VM resides. Disk size varies depending on the

license.

= Google Cloud Platform & DevProject 001 +

ﬁ:ﬁ & Create adisk
-] Name
jkato-fmg-564-testd0s
o
Description (0tiona
2]
a 4
Region Zone
us-centrall (lowa) - us-centrall-f -
B
Type
R Standard persistent disk -
B Source type
_ Image = Snapshot | Blank disk
Size (GB)
a 200
& Estimated performance
® Operation type Read Write
=] Sustained random IOPS limit 150.00 300.00
Sustained throughput limit (MB/s) 24.00 24.00
]
Encryption
-3 Data is encrypted automatically. Select an encryption key management solution.
() managed key
o configuration require
Customer-managed key
Manage via Google Cloud Key Managemen Service
Customer-supplied key
Manage outside of Google Cloud
This new disk will be added once you create the new instance
&
Cancel
> Equivalent REST or command line

4. Click Create. Ensure the disk appears in the Disks list.
5. You must attach the disk to the FortiManager-VM instance. Navigate to the FortiManager-VM instance and start

the gcloud command.

FortiManager GCP Cookbook
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Deploying FortiManager on GCP 12

= Google Cloud Platform & DevProject 001

EE} & VMinstance details / EDIT ) RESET
a Details Monitoring
13 & jkato-fmg-564-test002
&l Remote access
SSH |~ Connect to serial console E
9]

¥ E

g Serial port 1 (console)
Connecting to serial ports is enabled in pr

Serial port 2
] Logs Serial port 3
Stackdriver Logging Serial port 4
R Serial port 1 (console) | View gcloud command I
More
%o
Machine type
== nl-standard-2 (2 vCPUs, 7.5 GB memory)
a CPU platform
Intel Ivy Bridge
H Zone
® us-centrall-f
Labels
H e Ara ibata fann

6. Click RUN IN CLOUD SHELL.

gcloud command line

This is the geloud command line with the parameters you have selected

66400 connect-to-serial-port jkato-faz564-teste02-opensource-vm --zone=u

¥ Line wrapping

geloud reference

CLOSE | RUNIN CLOUD SHELL

7. Delete the lines that appear in the command line.

B oA 001-166400) X =+ ra

8. Enter the following command:
gcloud compute instances attach-disk [INSTANCE NAME] --disk [DISK NAME]

For example, the above instance has the instance name “jkato-fmg-564-test002” and disk name “jkato-fmg-564-
test005". In this case, the command is as follows:
gcloud compute instances attach-disk jkato-fmg-564-test002 --disk jkato-fmg-564-test005

FortiManager GCP Cookbook Fortinet Technologies Inc.



Deploying FortiManager on GCP

1.

12.

13.

FortiManager GCP Cookbook

After attaching the disk, log into the FortiManager-VM management GUI.

Click System Settings. Invoke the command line by clicking the icon in the CLI Console widget.

§iE Toggle Widgets v

S FORTINET

& Network System Resources oo
MHA
2 Admin = FortiManager-VMé4-
GCP
Administrators 2% 11%
Profile

Remote Authentication Server

ge CPU Usags Memory Usags Disk Usags Alert Message Console = &,
Admin Settings bl MR N il 3o x
. Time Message
BH Certificates -
Jul 4 :
Local Certificates CLI Console ~ x  14:2029
CA Certificates — Jul 4
o connect. .. 14:20:22
CRL Jul 4
i Event Log 10:09:45
[ Task Monitor el
09:20:36
B Advanced > Jul 4
il 06:14:35
Juld,
Mail Server 03:07:39

Syslog Server jul 4 =

In the command line window, enter exec 1vm info. The recently added disk is shown as Unused.

FMG-VM64-GCP # exec lvm info
LVM Status: Not-Started
LVM size: @GB

Diskl : Unused
Disk2 : Unavailable
Disk3 : Unavailable
Disk4 : Unavailable
Disk5 : Unavailable
Diské : Unavailable
Disk7 : Unavailable
Disk8 : Unavailable
Disk9 : Unavailable
Disk1@: Unavailable
Diskll: Unavailable
Disk12: Unavailable
Disk13: Unavailable
Diskl4: Unavailable
Disk15: Unavailable

Enterexec 1lvm start to start LVM disk management. Enter y to continue. The system reboots.

FMG-VMB4-GCP # exec lvm start

This operation will start managing disks using LVM.
All the data on the log disk will be ERASED!
Please backup your data before starting LVM.

The unit will REBOOT.

Do you want to continue? (y/n)

Rebooting causes the connection to the CLI console and the management GUI to be lost. Repeat steps 9 to 11.

The disk now appears as Used.

FMG-VM64-GCP #
FMG-VM64-GCP # exec lvm info
LVM Status: OK
LVM size: 209GB

Disk1 : Used
Disk2 : Unavailable
Disk3 : Unavailable
Disk4 : Unavailable
Disk5 : Unavailable
Diské : Unavailable
Disk7 : Unavailable
Disk8 : Unavailable
Disk9 : Unavailable
Disk1@: Unavailable
Disk11l: Unavailable
Disk12: Unavailable
Disk13: Unavailable
Diskl4: Unavailable
Disk15: Unavailable

13
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Deploying FortiManager on GCP 14

14. Runexec lvm extend. Thisincorporates the disk into the FortiManager system.

FMG-VM64-GCP #
FMG-VMB4-GCP # exec lvm extend

This operation will need to reboot the system.
Do you want to continue? (y/n)

15. To add more disks later, follow steps 4 to 6 in Technical Note: Extending disk space in FortiAnalyzer VM /
FortiManager VM.

16. Go to the Dashboard. You will now have sufficient disk space.

System Settings v SR 1 : admin v
foggle Widgets v
& All ADOMs g
System Information o ox License Information o
€ Network
o Host Name FMG-VM64-GCP ra EB VM License Type Valid
2 Admi Serial Number FMG-VMO0000000000 [@ Management Devices/VDOMs 0of 10
imin &
R Platform Type FMG-VM64-GCP @ FortiGuard VM Meter Service No License
Profile HA Status Standalone Server Location m= Servers located in US only Vd
Remote Authentication Server System Time Wed Jul 04 15:15:01 2018 PDT Pd 2 Update Server Antivirus and IPS 173.243.138.78 (== Sunnyvale, CA, United
Admin Settings Firmware Version v5.6.4-buikd4245 180627 (GA) & States)
@8 Certificates ~ System Configuration Last Backup : N/A A lx Web and Email Filter ~ 209.222.147.36 (8 Ashburn, VA, United
Local Certificates Current Administrators admin /1 in total = States)
CA Certificates Up Time 1 minute 7 seconds FortiClient Update 96.45.33.105 (ms Sunnyvale, CA, United
State:
CRL Administrative Domain oFF g
&8 Event Log
FortiAnalyzer Features OFF Unit Operation o ox
(2 Task Monitor
B Advanced ~ |  System Resources Box FORTI N ET
SNMP ~ |
Mail Server \
Syslog Server 22% 8% 1% FortiManager-VMé64-GCP
Meta Fields G Restart
Advanced Settings
Avsafigzli Usage Memory Usage Disk Usage Alert Message Console BOCX
Time Message =
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Security Fabric connector integration with GCP

You can use FortiManager to create Fabric connectors for GCP and install the Fabric connectors to FortiOS.

The Fabric connectors in FortiManager define the connector type and include information for FortiOS to communicate
with and authenticate with the products. In some cases the FortiGate must communicate with products through the
Fabric connector, and in other cases the FortiGate communicates directly with the products.

FortiOS works with the Fabric connector to communicate directly with GCP.
Following is an overview of creating Fabric connectors for GCP using FortiManager:

1. Create a Fabric connector object for GCP. See Creating a GCP Fabric connector on page 15.

2. Import address names from GCP to the Fabric connector object. See Importing address names to a Fabric
connectors on page 16. FortiManager imports the address names and converts them to firewall address objects.
The objects do not yet include IP addresses and display on the Firewall Objects > Addresses pane.

3. Inthe policy package where you will create the new policy, create an IPv4 policy and include the firewall address
objects for GCP. See Creating IP policies on page 16.

4. |[nstall the policy package to FortiOS. See Installing policy packages on page 17.
FortiOS communicates with GCP to dynamically populate the firewall address objects with IP addresses.

Creating a GCP Fabric connector

With FortiManager, you can create a Fabric connector for GCP, then import address names from GCP to automatically
create dynamic objects that you can use in policies. When you install the policies to one or more FortiGates, FortiOS

uses the information and the Fabric connector to communicate with GCP and dynamically populate the objects with
IP addresses.

When you create a GCP Fabric connector, you specify how FortiOS can communicate with GCP through the Fabric
connector. As a result, you are configuring communication and authentication information for the Fabric connector.

If you have enabled ADOMSs, you can create multiple Fabric connectors per ADOM. Each Fabric connector requires a
unique IP address.

Requirements:

« FortiManager with ADOM version 6.0 or later.
« FortiManager is managing the FortiGate.
« You have configured the managed FortiGate to work with GCP.

To create a GCP Fabric connector:

1. Go to Fabric View > Fabric Connectors.
2. Click Create New. The Create New Fabric Connector wizard displays.
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Security Fabric connector integration with GCP 16

3. Under SDN, select Google Cloud Platform, and click Next. The Google Cloud Platform screen displays.
4. Configure the following options, and then click OK:

Name Type a name for the fabric connector object.

Type Displays Google Cloud Platform (GCP).

Project Name Specify the Fabric connector project name.

Service Account Email Specify the Fabric connector project name. service account email.
Private Key Specify the Fabric connector private key.

Update Interval (s) Specify the Fabric connector update interval:

 Click Use Default to use the default interval.
 Click Specify and specify the interval.

Status Toggle Onto enable the Fabric connector. Toggle OFF to disable the Fabric
connector.

Importing address names to a Fabric connectors

After you configure a Fabric connector, you can import dynamic objects from cloud platforms, such as GCP, to the
Fabric connector, and dynamic firewall address objects are automatically created.

To import address names for GCP:

1. Goto Policy & Objects > Object Configurations.
2. Inthe tree menu, go to Security Fabric > Fabric Connectors.

3. Inthe content pane, right-click the GCP Fabric connector, and select Import. The Import SDN Connector dialog
box displays.

4. Select the address names, and click Import. FortiManager imports the address names and converts them to
dynamic firewall address objects that display on the Firewall Objects > Addresses pane.

Creating IP policies

The section describes how to create new IPv4 and IPv6 policies.

IPv6 security policies are created both for an IPv6 network and a transitional network. A transitional network is a network
that is transitioning over to IPv6, but must still have access to the Internet or must connect over an IPv4 network. IPv6
policies allow for this specific type of traffic to travel between the IPv6 and IPv4 networks.

Ay
‘Q' On the Policy & Objects tab, from the Tools menu, select Display Options. In the Policy
|| section, select the IPv6 Policy checkbox to display this option.

FortiManager GCP Cookbook Fortinet Technologies Inc.



Security Fabric connector integration with GCP 17

To create a new IPv4 or IPv6 policy:

1. Ensure that you are in the correct ADOM.

2. Goto Policy & Objects > Policy Packages.

3. Inthe tree menu for the policy package in which you will be creating the new policy, select IPv4 Policy or IPv6
Policy. If you are in the Global Database ADOM, select IPv4 Header Policy, IPv4 Footer Policy, IPv6 Header
Policy, or IPv6 Footer Policy.

4. Click Create New, or, from the Create New menu, select Insert Above or Insert Below. By default, policies will be
added to the bottom of the list, but above the implicit policy. The Create New Policy pane opens.

Create New IPv4 Policy

Name

Incoming Interface rany [}

Outgoing Interface rany Q
Source Internet Service OFF
Source Address “xall []
Source User +
Source User Group +
Source Device +
Destination Internet Service OFF
Destination Address rall Q
Service <FALL (]
Schedule Cralways (]
Action Accept | IPSEC
Log Traffic Log Violation Traffic

Generate Logs when Session Starts
Comments
Meta Fields >

Advanced Options >
I
5. Complete the options.

6. Click OK to create the policy.

You can select to enable or disable the policy in the right-click menu. When disabled, a disabled icon will be
displayed in the Seq.# column to the left of the number.

Installing policy packages

When installing a policy package, objects that are referenced in the policy will be installed to the target device. Default
or per-device mapping must exist or the installation will fail.

vy
‘Q' Some objects that are not directly referenced in the policy will also be installed to the target

device, such as FSSO polling objects, address and profile groups, and CA certificates.
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Security Fabric connector integration with GCP

To install a policy package to a target device:

1. Ensure you are in the ADOM that contains the policy package.
2. Goto Policy & Objects > Policy Packages.

18

3. Select a policy package and from the Install menu or right-click menu select Install Wizard. The Install Wizard

opens.

4. Follow the steps in the install wizard to install the policy package. You can select to install policy package and

device settings or install the interface policy only.

FortiManager GCP Cookbook
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